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Projeto Erasmus+: BIMVET3 2020-1-ES01-KA203-083262
Este Projeto Erasmus+ foi financiado com o apoio da Comissdo Europeia. Esta publicagdo reflete apenas os pontos de vista dos autores, e a
Comissdo Europeia e as Agéncias Nacionais Erasmus+ ndo podem ser responsabilizadas por qualquer utilizagdo que possa ser feita das
informagdes ai contidas.

Titulo: MODELO BIM COM REVIT MEP
1 - Objetivos
Capacidade de desenvolver um modelo BIM MEP, especificamente no sistema de distribuicao de dgua.

Capacidade de criar vistas isométricas e folhas usando o software Revit.

Capacidade de transmitir informacgdes usando BIM.
2 — Metodologia de aprendizagem

O professor dard uma explicacdo sobre o uso da ferramenta.

Os alunos lerdo este tutorial e verdo os videos, executarao o exercicio e explorardo as ferramentas e o
ambiente MEP.

Para avaliar a realizagdo da pratica, cada aluno precisa criar o sistema de Agua Fria Doméstica e os
desenhos das folhas.

3 — Duragao do tutorial

A pratica descrita neste tutorial sera realizada em uma sala de aula de informatica.
Tera a duracdo de 6 horas de ensino.

4 — Recursos necessarios

Sala de informatica com computadores com acesso a internet.
Software necessario: Revit.

Hardware necessario: Computador com capacidade para suportar o software.

5—- Conteudo & tutorial
5.1 Introducao
5.2 Interface do Revit MEP
5.3 Iniciar um projeto

5.4 Vincular Modelo de Arquitetura
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5.5 Adicionar Niveis
5.6 Sistemas de distribuicao de aguas
5.6.1 Equipamentos sanitdarios
5.6.2 Criar um sistema de agua fria doméstica
5.6.3 Anotagoes
5.6.4 Criar tabelas
5.6.5 Criar vistas isométricas
5.6.6 Criar Folhas
6- Entregaveis
Um relatério de 3 paginas mostrando a execuc¢do deste exercicio.

7- O que aprendemos

Como vincular um modelo de arquitetura no projeto MEP.

Como colocar tubagens

Como criar um sistema de Agua Fria Doméstica, com tubagens e conexdes.

8 - Ficheiros utilizados neste tutorial

O ficheiro de projeto criado no tutorial do Revit Architecture no formato .rvt.

5.1 Introdugao

O Revit MEP é uma parte ou funcionalidade do software Autodesk Revit, voltada para profissionais que
trabalham com projetos de instalacdes mecénicas (Mechanical), elétricas (Electrical ) e de distribuicdo de
tubagens de 4gua (Plumbing), isoladamente ou como parte de um projeto BIM. E um conjunto de
ferramentas do Revit que permitem a elabora¢do de modelos BIM, utilizadas para agilizar o processo de
projetos de engenharia, tornando o projeto e o desenvolvimento de produtos mais eficiente.
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Este tutorial ndo tem como objetivo ensinar a dimensionar os sistemas em edificios, mas sim como utilizar
as principais ferramentas do Revit para modelar os sistemas. E um exercicio de exploracio do sistema,
gue ndo tem em consideracdo as regras de instalacdo de sistemas as quais variam conforme o pais.

Neste tutorial serdo utilizadas as Familias basicas da biblioteca do Revit. Contudo, atualmente diversas
marcas que fabricam componentes de sistemas disponibilizam em seus websites para download as suas
familias configuradas de acordo com as dimensGes, materiais e outros parametros encontrados no
mercado, para que o projeto se aproxime o maximo da realidade.

5.2 Interface do Revit MEP

E importante compreender que o Revit MEP n3o é um software independente do Revit e sim uma parte
dele, ou seja, o Revit MEP esta inserido no préprio Revit.

Como no tutorial Revit Architecture ja foi possivel a familiarizacgdo com o ambiente de trabalho e as
ferramentas de navegacao e edicdo, no video seguinte serdo demonstradas algumas ferramentas de uso
especifico de projetos MEP.

https://www.youtube.com/watch?v=m3V97Pxsdt4

5.3 Iniciar um Projeto


https://www.youtube.com/watch?v=m3V97Pxsdt4
https://www.youtube.com/watch?v=m3V97Pxsdt4

BIMVET3

Revit MEP
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Apds abrir o programa, na pagina inicial do Revit deve-se clicar em New e serd aberta a janela New Project
para selecionar o Template de projeto a ser trabalhado. Neste caso, sera utilizado um template pré-
definido do Revit, o Metric-Systems.

MODELS

2 Open..

MODELS

[ New.

FAMILIES

= Open..

[ New.

@ Recent Files

B BIM360

Sample Architecture Proj...

New Project

Template file

<None>

<None>

Imperial-Construction Template
C|Tmperial-Architectural Template
Imperial-Structural Template

{1mperial-Systems Template late
Metric-Construction Template
Metric-Architectural Template

Metric-Structural Template

Help

Sample Structure Project

Se o Template Metric-Systems nao aparecer nas opgdes da janela New Project, deve-se clicar em Browse

para carregar este modelo. Serd aberta a janela Choose Template, e na pasta English (Program
Data/Autodesk/RVT 2022/Templates/English), selecionar o ficheiro “Systems-Default Metric”, depois
clicar em Open para carrega-lo.

R Choose Template

Look in:

My Computer
A

English

Nome

DefaultMetric

DefaultUS-Canada
Electrical-Default_Metric
Electrical-DefaultGBRENU
LT_USM_Default
Mechanical-Default_Metric
Mechanical-DefaultGBRENU
Plumbing-Default_Metric
Plumbing-DefaultGBRENU

Precast Detailing-DefaultMetric
Residential GBRENU

Structural Analysis-DefaultGBRENU
Structural Analysis-DefaultMetric
Structural Analysis-DefaultMetric-Up
Structural Analysis-DefaultUS-Canada
Systems-Default_Metric
Systems-DefaultGBRENU

UK Pipe Template

£

Data de modificagdo
17/01/2020 15:40
17/01/2020 15:40
17/01/2020 15:39
19/01/2020 15:40
17/01/2020 15:42
17/01/2020 15:40
19/01/2020 15:40
17/01/2020 15:42
19/01/2020 15:40
17/01/2020 15:42
19/01/2020 15:39
19/01/2020 15:40
17/01/2020 15:42
17/01/2020 15:42
17/01/2020 15:42
17/01/2020 15:40
19/01/2020 15:40
19/01/2020 15:40

? X

vq—ﬁixﬁl!iewsv

File name: | Systems-Default_Metric.rte

Files of type: | Template Files (*.rte)

1A Preview
v

!
!
!
!
!
! .
!
!
!
!
!
!
!
!
!
!
!
Iv

~

~

Open Cancel

Depois de carregado o Template, deve seleciona-lo na janela New Project e em Create New marcar a opgao

Project.
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New Project X
Template file
Systems-Default_Metric.rte L
Create new
(@ Project () Project template
oK Cancel Help

Apds abrir o Template é importante definir as unidades de medida que serao utilizadas no projeto. Para
isso deve-se clicar no separador Manage, painel Settings e selecionar a op¢ao Project Units.

u_ Project Parameters f‘é Transfer Project Standards
F]

s= Shared Parameters u_‘_':ﬂ Purge Unused

Q Global Parameters Project Units
Settings

A seguir ird abrir-se uma janela onde sdo mostradas as unidades de medida para cada um dos parametros.
Ter-se-a de alterar o parametro Length o qual sera alterado para Meters, com duas casas decimais, e
também o parametro Slope que sera alterado para Percentage. Para as areas, volumes e angulos, deve-
se definir também duas casas decimais na op¢do de arredondamento.

Project Units X
Discipline: Commaon ~
Units Format ()
Angle 12.35°
Area 1234.57 m*
Length| 123457 m
Mass Density 123457 kg/m*
Slope | 12.35%
Speed 1234.6 km/h
Time 12346 s
Volume | 123457 m?
Currency 123457
v

Decimal symbol/digit grouping:
123,456,789.00 -
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Format X
Use project settings
Units: Maters v
Rounding:
2 decimal places | | 0.01
Unit symbol:

m ~

[ Suppress trailing 0's
Suppress 0 feet
Show + for positive values
[Juse digit grouping

Suppress spaces

Enz

5.4 Vincular Modelo de Arquitetura

Os projetos MEP sdao normalmente criados usando modelos de arquitetura vinculados. A vinculagdo
permite trabalhar de uma maneira colaborativa e coordenada entre as disciplinas de arquitetura e MEP.
Se o modelo vinculado no projeto for modificado, o Revit atualizard automaticamente o modelo cada vez
gue o projeto for aberto.

Neste tutorial, sera utilizado o modelo de arquitetura que foi criado anteriormente no tutorial Revit
Architecture. Para vincular, deve-se aceder ao separador Insert e clicar no icone Link Revit.

B®c) B O

Link | Link Link Link DWF
Revit| IFC CAD Topography Markup

Surge entdo uma janela para selecionar o ficheiro a ser importado. Procurar pelo ficheiro do projeto
feito no tutorial Revit Architecture, seleciona-lo. Para Positioning, especificar a op¢do desejada, na
maioria dos casos, deve selecionar Auto — Internal Origin to Internal Origin . Clicar em Open.
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R Import/Link RVT

Look in: | [ Area de Trabalho

Nome
@ OneDrive - Personal

2
S Este Computador ﬁ

1 Bibliotecas

Documents ¥ Rede
e
My Computer
'y
m Architecture
=

My Netwo...

Favorites

File name: ‘

Files of type: |RVT Files (*.nvt)

Positioning: ‘Aulo - Internal Origin to Internal Origin

Cancel

o |7

O modelo vinculado serd exibido na Area de desenho.

Sempre que o cursor do rato passe sobre o desenho do Link do modelo de arquitetura, aparece uma Caixa
azul de selegdo. Algumas vezes, estas linhas azuis atrapalham a visualizagdo do projeto.
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RVT Links : Linked Revit Model : Architecture.nvt : 2
ocation <Not Shared>

Para desabilitar a selecdo de modelos vinculados, deve-se clicar no icone Select Links, na barra de filtros
de selegdo para que a caixa de selegao fique inativa.

[#]= & o o Po
5.5 Adicionar Niveis

O template pré-definido (Systems-Default_Metric), disponibiliza apenas 2 pisos (Level 1 e Level 2), e
conforme a necessidade de cada projeto pode ser preciso criar mais.

Ao abrir uma das vistas Elevations pelo Navegador de Projeto é possivel visualizar os niveis do template e
os niveis do modelo importado (Basement, Ground Floor e Roof) também s3o visiveis.

Os niveis do modelo de arquitetura importado sdo apenas uma representagao grafica, ndo sendo possivel
serem utilizados como referéncia no projeto atual. Todos os elementos do modelo importado ficam em
um unico bloco, o que impossibilita a alteracdo, portanto é necessario inserir no projeto atual niveis que
sobreponham os do modelo de arquitetura.

Roof
6.00m G
Level 2 .\;
o o F - = - — 400m

Ground Floor
2680m G

Level 1 S Basement
0.00m 0.00m @
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Recomenda-se que o Level 1 e Level 2 sejam renomeados para “Basement” e “Ground Floor”,
respetivamente, e que suas alturas sejam alteradas de modo que figuem em cima dos niveis do desenho
importado (0,00 m e 2,60 m). Criar um terceiro nivel e nomea-lo como Roof, com altura de 6,00 m.

Para criar este novo nivel, para o Roof, no separador Architecture, painel Datum, clicar em Level.
off Grid

Datum

Ao aproximar o cursor do rato do nivel Ground Floor, surgirad entdo uma cota tempordria em relagao ao
nivel Ground Floor, que serve como uma pré-visualizacdo do nivel que sera inserido. Conforme o
movimento do rato, a cota é alterada.

Ground Floor G
260m

Basement
T T oo00m s

Em relagdo ao Ground floor, o novo piso terd 3,40 m. Apds visualizar a cota temporaria de 3,40 m, basta

clicar na area de desenho e o novo nivel sera inserido.

Roof G
6.00m

— EOUFIG Floor @
260m

o 1 o o o o _ Basement G
0.00m

Além de se criar um nivel para cada andar no edificio, também se pode criar niveis de referéncia, como o

nivel do peitoril.
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5.6 Sistemas de distribuicao de aguas

O sistema de dguas domésticas é dividido nos seguintes sistemas: de Agua Fria, Agua Quente e Esgoto
Sanitdrio. Neste tutorial serd dado um exemplo de criacio de sistema de Agua Fria Doméstica.

5.6.1 Equipamentos sanitarios

Antes de iniciar a criagdo de um sistema, é preciso inserir os equipamentos sanitdrios, como pias, sanitas,
banheiras, etc. Mesmo que estes elementos ja tenham sido adicionados no modelo de Arquitetura,
guando a arquitetura é inserida através do link Revit todos os seus elementos ficam em um Unico bloco,
o que impossibilita a altera¢do. Portanto, é necessario inserir no projeto hidraulico a familia novamente,
sobrepondo a da arquitetura.

Sendo assim, no Navegador de Projeto, abrir a vista “1- Plumbing”, que corresponde a planta Basement
(se for necessario, é possivel renomea-la).

Project Browser - Projeto MEP X
=0, Views (Discipline)
Electrical
Mechanical
= Plumbing
7
HVAC
=l Plumbing
[=--Foor Plans
1 - Plumbing
2 - Plumbing
3D Views
Elevations (Building Elevation)
F| Legends
™ Schedules/Quantities (all)
Sheets (all)
2] ramilies
[@] Groups
&3 Revit Links

No separador Systems, no painel Plumbing & Piping, clicar no icone Plumbing Fixture.

=— K =

& : — iy % e
Pipe Pipe Parallel Plumbing Eprinkler

Placeholder Pipes 'Q',}, Fixture T

—
Plumbing & Piping s

Na janela Properties ira aparecer um equipamento qualquer selecionado pelo Revit. Para alterar o
equipamento selecionado, basta clicar na imagem/descri¢do do elemento.

10
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Properties X
. M_Sink - Island - Single -
455 mmx455 mm - Public
New Plumbing Fixtures ~ Edit Type
Constraints Gl ~
Schedule Level Level 1
Elevation from Level 0.0
Host <not associated »
Plumbing b
Flow Pressure 155158.000000 Pa
Mechanical £y
System Classification Domestic Cold Water,Do..
System Type Undefined
System Name
System Abbreviation

Identity Data =
Properties help Apply

Serd aberto entdo o Type Selector, onde aparece uma lista de diversas familias de equipamentos do Revit.
Utilizar a barra de rolagem para ver todas as pecas disponiveis.

M_Sink - Island - Single
455 mmx455 mm - Public

lSecr[h

| £2U INIT SUINED = U I Uidin

250 mm Strainer - 80 mm Drain

250 mm Strainer - 100 mm Drain
. M_Sink - Island - Single

455 mmx455 mm - Private

[ 455 mmss mm - public

' M _Sink - Kitchen - Double

1065 mmx535 mm - Private

1065 mmx535 mm - Public

. M_Sink - Mop

710 mmx710 mm

‘ M_Urinal - Wall Hung

20 mm Flush Valve

25 mm Flush Valve
Q M_Water Closet - Flush Valve - Wall Mounted

Private - 6.1 Lpf
Private - Flushing Greater than 6.1 Lpf
Public - 6.1 Lpf

Public - Flushing Greater than 6.1 Lpf

Para este exemplo, ndo serdo utilizados nenhum dos equipamentos que aparecem inicialmente na lista
do Type Selector, pois serdo carregadas novas familias. Para isso, depois de clicar no separador Systems e
no icone Plumbing Fixture, sera aberto o separador Modify | Place Plumbing Fixture, e entdo deve-se clicar
em Load Family.

11
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Manage Add-Ins Modify | Place Plumbing Fixture

B | &2 © @

Load | Model [Place on| Place on Tag on
Family [in-place Face |Work Plane Placement

Mode Placement Tag

Serd aberta a janela Load Family, na qual se deve aceder ao seguinte caminho:
ProgramData/Autodesk/RVT 2022/Libraries/English/Plumbing/MEP/Fixtures. Dentro da pasta Fixtures,
ha diversas pastas nomeadas conforme o tipo de equipamento. Abrir a pasta Water Closets.

R Load Family ? X

Lookm:| Fixtures V| 4= ., X B Views ~

Freview

Nome Tipo

Water Closets
Urinals

Sinks

Showers
Lavatories
Emergency Fixtures
f\ Drinking Fountains
Drains

Connectors
Bathtubs
Appliances

My Computer

File name: | V|

Files of type: |AII Supported Files (*.rfa, *.adsk) w |

| Open | ‘ Cancel |

Ao abrir a pasta Water Closets, aparecem algumas familias de elementos desta classificacdo. Pressionando
a tecla CTRL, selecionar as familias: “M_Water Closet — Flush Tank” e “M_Bidet”, e clicar em Open para
carrega-las no projeto.

12
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R Load Family ? X
s Fis Water Closets v| - E} X I:'_l Views ¥
) Preview

ﬁlﬁ MNome Tipo

= M_Water Closet - Quiet Flush Tank
M_Water Closet - Flush Valve - Wall Mounted
M_Water Closet - Flush Valve - Floor Mounted

rﬁ M_Water Closet - Flush Tank
M_Bidet

T
‘ﬂi-'l
My Computer
s
|
File name: | M_Water Closet - Flush Tank.rfa w
Files of type: | All Supported Files (*.rfa, *.adsk) ~
Open Cancel

Repetir o mesmo processo para carregar as seguintes familias:

e Sinks:
- M_Sink - Work
- M_Sink — Service
e Showers:

- M_Shower Stall — Rectangular
Nota: Na janela Properties, duplicar o elemento e criar 4 novos tipos com as seguintes dimensdes:
1,60 mx 1,00 m
1,30mx 1,30 m
1,45mx 0,90 m
1,20mx 0,90 m
e lavatories:
- M_Lavatory - Rectangular
e Bathtubs:
- M_Bath Tub — Maestro
Nota: Na janela Properties, clicar em Edit Type e alterar os parametros Bath Tube Width para 1,10 m e Bath
Tube Length para 2,50 m.
e Appliances:
- M_Washing Machine
- M_Dishwasher

Depois de carregar todas as familias, pode-se inserir estes elementos na vista. No separador Systems,
painel Plumbing & Piping, clicar no icone Plumbing Fixture. Agora na janela Properties, no Type Selector
aparecem todas as familias carregadas. Selecionar o tipo “Private - 6.1 Lpf” da familia “M_Water Closed —
Flush Tank”.

13
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Properties. X [ 2-Plumbing X
M_Water Closet - Flush Tank - u@
Private - 6.1 Lpf
[search L
25 mm Flush Valve ~
' M_Water Closet - Flush Tank
\ Private - 6.1 Lpf

Private - Flushing Greater than 6.1 Lpf M_Water Closet - Flush Tank
Public - 6.1 Lpf
Public - Flushing Greater than 6.1 Lpf

Q M_Water Closet - Flush Valve - Wall Mounted

Private - 6.1 Lpf
Private - Flushing Greater than 6.1 Lpf

Public - 6.1 Lpf
Public - Flushing Greater than 6.1 Lpf
‘ M_Whirlpool Spa
Mnst Rocontly | lcorl Tunee

Com o elemento selecionado, aproximar o cursor de onde desejar inseri-lo. Para rotacionar o objeto,
pode-se utilizar a barra de espaco do teclado. Quando o objeto estiver posicionado, basta clicar sobre o
desenho para que ele seja inserido.

15.0 mim

22081

Ao clicar sobre o equipamento inserido, a janela Properties identifica o objeto e podem ser feitas
alteragGes personalizadas de acordo com cada projeto. Proximo do objeto, aparecem as identificacGes
das ligacOes de abastecimento e drenagem de agua.

14
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3.00FU,
Oui
80.0 mm

b

Inserir todos os outros elementos com a seguinte distribuicdo:

Vista: 1- Plumbing (planta do piso Basement):

WC 1:
= M_Water Closet — Flush Tank — Private 6.1 Lpf
= M_Lavatory — Rectangular — Private — 560 mmx560 mm
= M_Shower Stall — Rectangular - 1,60 m x 1,00 m - Private
WC 2:

= M_Water Closet — Flush Tank — Private 6.1 Lpf
= M_Lavatory — Rectangular — Private — 560 mmx560 mm
= M_Shower Stall — Rectangular - 1,45 m x 0,90 m — Private

Vista: 2 - Plumbing (planta do piso Ground Floor):
- Bathroom 1:

15



Co-funded by the
3 Revit MEP Erasmus+ Programme
of the European Union

= M_Water Closet — Flush Tank — Private 6.1 Lpf

= M_Bidet

= M_Bath Tub — Maestro — Private

= M_Llavatory — Rectangular — Private — 560 mmx560 mm

= M_Shower Stall — Rectangular - 1,30 m x 1,30 m - Private
- Bathroom 2:

= M_Water Closet — Flush Tank — Private 6.1 Lpf

= M_Lavatory — Rectangular — Private — 560 mmx560 mm

= M_Shower Stall — Rectangular - 1,60 m x 1,00 m - Private
- Bathroom 3:

= M_Water Closet — Flush Tank — Private 6.1 Lpf

= M_Llavatory — Rectangular — Private — 560 mmx560 mm

= M_Shower Stall — Rectangular - 1,20 m x 0,90 m - Private
- Kitchen:

=  M_Sink —Work

= M_Dishwasher

= M_Water Closet — Flush Tank — Private 6.1 Lpf

= M _Llavatory — Rectangular — Private — 560 mmx560 mm
- Laundry Room:

= M_Sink — Service

- Storage:
= M_Washing Machine
(P77 7 F7 7] VI 7] FZZ7 FTFTTTTTTTTTTZ T
i g
%
H [§ STORAGE 4
& KITCHEN M f
f EEE s A
| we ot RooM |
14 K ?//////////////////////
A %
f//////////////////////////////// 77 A
i /]
¢ 7]
1 ¥
7z 77777 T F T T T FTTTZ 7T TZT 7777 77 A
4 s < 4]
% i H
LA
) e M P o g ] DATHRODM
- — | : i % A Il Al I [ %
i i I 4 g B bl B
i} i / g ¢ B ! ¥
B i i % % - ]
| g i % A BATHROOM )
- I h_ i % 4 2@l ;
;. BATHROOM i f 7 § ¢
ik ; ‘) 4 7 i W %
///////////////// (7T 7T FZ 7T T2 d % 77 f 77 (7ZZ A
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> Nota: Para o elemento “M_Sink - Work" é necessario editar a elevagdo em relagdo ao piso.
Para isso, selecionar o elemento e na janela Properties, no campo Elevation from level,

preencher com o valor de 0,80 m.
Properties X

M_Sink - Work
510 mmx455 mm

Plumbing Fixtures (1) + | 3 Edit Type
Constraints Gl A~
Level Ground Floor
Elevation from Level 0.8000 m
Host Level : Ground Floor
Offset from Host 0.8000 m
Plumbing 2
Flow Pressure 551 58.000000 Pa
Mechanical K]
System Classification éDornest'c Cold ‘;".-’ater.Do...é v
Properties help Apply

5.6.2 Criar um sistema de agua fria doméstica

Depois de inserir todos os equipamentos sanitarios, pode-se iniciar a criacdo do tracado rede de agua fria.
Para isso, deve-se clicar sobre um dos equipamentos sanitdrios inseridos, e a seguir no icone Piping no
separador Modify.

Modify | Plumbing Fixtures

= [
Connect Piping
Into

1 lLayout Create Systems

Surgird a janela Create Piping System, na qual em System type deve-se selecionar a op¢dao Domestic Cold
Water, no campo System name pode-se alterar o nome do sistema (neste caso serd mantido), e deve-se
marcar a opg¢ao Open in System Editor. Depois destas defini¢des, clicar em OK.

Create Piping System ? b

System type: Domestic Cold Water ~

System name: | Domestic Cold Water 1

[~]Open in System Editor

Selecionar a ferramenta Add to System, para adicionar os demais equipamentos no sistema.

17
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L] loao (=
|5 &g s + 4 X
Modify |Properties Add Remaove Select Finish Cancel
to System f§from System | Equipment Editing System Editing System

ki

Select » Properties Edit Piping System Mode

Aproximar o cursor do rato e clicar sobre todos os equipamentos sanitarios dos pisos Basement e Ground
Floor.

Depois de selecionar todos os equipamentos, clicar em Finish Edit System ¥ .

Ha duas formas de realizar o tracado das tubagens: de forma manual ou através de solucdes automaticas
geradas pelo Revit, que podem ser personalizadas.

Para gerar de forma automatica, basta clicar em um dos elementos que foi adicionado ao sistema e no
painel Modify | Plumbing Fixtures, clicar no icone Generate Layout.

Maodify | Plumbing Fixtures  Piping Systems

L 4

Generate] Generate Connect Piping
Layout JPlaceholder Into

1 Layout Create Systems

O Revit entdo ird fazer a leitura dos elementos que foram adicionados ao sistema, e gerar solugdes a partir
da disposicdo destes elementos, na qual as tubagens e conexdes sdo inseridas automaticamente. Sera
aberto o separador Generate Layout, onde aparecem algumas ferramentas de edicao.

E 6} Slope Value: J X

Remove Place 0.0000% ¥  Finish Cancel
from System Base Layout Layout
Modify Layout Slope Generate Layout

Generate Layout Solution Type  Network ~ 2of2 Al Ik

Na barra Generate Layout, é possivel selecionar o tipo de solucdo em Solution Type, que pode ser do tipo
Network, Perimeter ou Intersection, conforme as preferéncias do projetista. Neste exemplo serd mantida
a opcao Network. Ao lado do tipo de solugdo, hd o nimero de solugbes geradas pelo Revit, neste caso,
foram geradas duas.
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v 2of2 <l I Settings ...

O modelo de projeto normalmente estabelece as elevagcbes e tipos de tubos, bem como os seus
didametros. No entanto, pode ser necessario especificar tipos de tubos e elevagGes padrdo para a tubagem

do sistema.

Ao clicar em Settings, é aberta a janela Pipe Conversion Settings. No item Main, no parametro Pipe Type,
selecionar o material “PVC - DWV” e em Offset, definir o valor de -0,20m, para as tubagens passarem

abaixo da laje. Para o item Branch realizar as mesmas alteragdes.

Main |

Branch

System Type: Domestic Cold Water

Setting

Value

Pipe Type

Pipe Types: PVC - DWV

Offset

-0.2000 m

oK Cancel

Uma das solucbes geradas pelo Revit foi a que estd representada na imagem abaixo (Solution 1/2 do tipo
Network). No entanto, pode-se observar que ndo é a solugdo ideal e é necessario fazer alguns ajustes. Por ser
uma solugdo gerada pelo software de forma automadtica, pode haver diferengas de um computador para outro,

e até mesmo mais solucdes.
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Para editar a solugdo, clicar em Edit Layout.

Remove
from System

Modify Layout

Com esta ferramenta é possivel arrastar as tubagens inseridas e reposiciona-las no Sistema. Neste caso,
ndo sera feita nenhuma edicdo, pois os ajustes também podem ser feitos manualmente for a da edicdo
do Layout.

Os diametros das tubagens e conexdes também serao alterados posteriormente, por definicdo todas
estdo com 15mm de didmetro.

Clicar em Finish Layout para concluir.

v X

Finish Cancel
Layout Layout

Generate Layout

Ao finalizar, poderao surgir alguns erros, um deles pode ser devido a alguma conexdo que ficou aberta
conforme a imagem a seguir.
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This element has an open connection. This may not be an error, but for flow
calculations to work correctly all connections should be sealed with an end cap.

O erro acima pode estar relacionado com outro erro por ndo haver espacgo para a colocacao de acessorios.
Warning: 3 out of 4

There was not enough room to place the required fittings. Consider increasing
the length of the segments, or moving them farther apart to generate a solution.

Ao mostrar as janelas de erros, o elemento é destacado no desenho para que se possa verificar. No
momento deve-se prosseguir, pois 0s erros serdo corrigidos posteriormente.

Pelo Navegador de Projeto, deve-se aceder a planta de piso “2- Plumbing” correspondente ao piso Ground
Floor. Como o Sistema foi inserido -0,20m abaixo da laje deste piso, 0 mesmo ndo estara visivel nesta
vista. Para torna-lo visivel, na janela Properties, no parametro View Range, clicar em Edit.

Properties
E:ﬁ Floor Plan v
Floor Plan: 2 - Plumbing ~ Edit Type
Sun Path D E
Underlay
Range: Base Level Basement
Range: Top Level Unbounded
Underlay Orientation Look down
Extents 5
Crop View ]
Crop Region Visible ]
Annotation Crop ]
| View Range Edit..
Associated Leve Ground Floaor
Scope Box MNone
Depth Clipping Nao clip
Identity Data A v
Properties help Apply

Serd aberta entdo a janela View Range. Em View Depth, alterar o parametro Level para “Unlimited” e
entdo clicar em OK.
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View Range

>

Primary Range

Top: Associated Level (Ground F Offset: | 4.0000 m
Cut plane: Associated Level (Ground F Offset: | 1.2000 m
Bottom: Associated Level (Ground F Offset: | 0.0000 m

View Depth

Level: Unlimited ~ Offset: | 0.0000 m
Learn more about view range

<< Show Apply Cancel

Sendo assim, todo o sistema fica visivel na vista deste piso.
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Uma dica importante que ajuda a melhorar a visualizagdo dos elementos, é diminuir a espessura das linhas
de contorno. Para isso, deve-se clicar na ferramenta Thin Lines, localizada na Barra de Ferramentas de
Acesso Répido.

REeGHG -®-»-8e2-F0A a-oFE]%B--

Outra dica que pode ajudar na visualizagao grafica, é definir o Detail Level com a opgao Fine, e o Visual
Style como Realistic ou Consistent Color.

[Elekx xme> o s <
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A partir do layout da rede gerado automaticamente pelo Revit, serdo feitas edicdes manuais para melhor
adequd-lo, de forma que as tubagens sejam otimizadas. Para este sistema hidraulico ndo hd somente uma
solucdo de projeto, portanto o tragado da rede varia de acordo com as preferéncias de trabalho.

Como exemplo demonstrativo, sera editada a regido do sistema mostrada na imagem abaixo. Sugere-se
que os tracados das demais regides também sejam editadas conforme preferéncias.

/
o L Vi ey |_
g 1 :

? ] P— //7// ////////////

.; g Z =

.i < 2 / !_

’ f f 70

] 7z / 1 / B

] o " / |

% ¥ /] |

o— / f Zs
L L /

Para auxiliar no tragado dos ajustes do sistema, pode-se abrir as vistas dos alcados (Elevations) pelo Navegador

de Projeto, e também criar vistas de cortes utilizando a ferramenta Sections 4 na Barra de Ferramentas de
Acesso Rapido.

Para comecar, no Bathroom 1 serdo excluidas as conexdes do Bidé e da Sanita, conforme a imagem a
seguir. Para excluir um elemento, basta clicar sobre o mesmo e pressionar a tecla delete. Verificar na vista
3D se todas as conexdes foram excluidas.
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manual, deve-se selecionar um dos elementos e clicar no icone

Para iniciar o tracado da rede de forma

A

150 AU

“In” do equipamento.

0
Out
1.00 FU

Surgira entdo uma linha que representa o tragado da tubagem, a qual move-se conforme o movimento
do cursor do rato. Observar a cota temporaria e inserir a 0,10 m para dentro da parede.

o
~f=)—

No separador Systems, painel Plumbing & Piping, selecionar a ferramenta Pipe.

& R = ﬁ

Pipe Pipe Parallel ﬁ Plumbing Sprinkler
Placehclder Pipes % Fixture
Plumbing & Piping

Na janela Properties, verificar se o tipo de tubagem “PVC — DWV” estd selecionado.
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Properties X

Pipe Types -
PVC - DWV

‘Pipes ) v Edit Type
Constraints A oA

Horizontal Justification {Center

Vertical Justification Middle

Reference Level Basement

Top Elevation 24107 m

Middle Elevation 24000 m

Bottom Elevation 23893 m

Start Middle Elevation 24000 m
End Middle Elevation 24000 m

Slope 0.0000%
Dimensions A
Cutside Diameter 21.3 mm
Inside Diameter 15.8 mm
Size 15 mme e
Properties help Apply

Na barra de opgdes verificar se o diametro de 15mm esta selecionado.

Maodify | Pipes Diameter:| 15.0 mm w

Com isso, aproximar o cursor do rato da extremidade de uma das conexdes ja inseridas, e arrastar até a
outra, para conectar os dois objetos.

[Boint. 15 mm @ 0.26 m

A tubagem que passa por baixo da sanita também sera excluida e serd tracada uma nova, com a
ferramenta Pipe, de modo que fique alinhada com a tubagem da outra extremidade

Deve-se selecionar a tubagem e exclui-la antes de criar a nova.
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| —

i ol
| 1

|

| i
i

Pela vista 3D, com o Visual Style na opgao Realistic, ao aproximar o rato da outra extremidade, nota-se
gue algumas conexdes permaneceram com trés saidas.

Para remover uma das saidas, basta clicar sobre a conexao e depois no icone ~ para remover. Neste
caso, como é uma ligacdo curta e em linha reta, a conexao sera totalmente removida.

-

15.0 mm

15.0 mm

15.0 mm O

Também pode ser preciso adicionar mais uma saida em alguma conexdo, como é o caso da conexdo que

ligara a nova tubagem até a sanita. Para isso, clicar no icone na direcdo desejada.
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15.0 mm
No separador Systems, selecionar a ferramenta Pipe e clicar na nova saida criada para a conexao, na Barra
de Opcdes, deve-se inserir o valor de -0,20 em Middle Elevation.

Middle Elevation:| -0.2000 m V‘ Apply

Arrastar a tubagem da saida da conexdo até a parede da conexdo da sanita, conforme as imagens a seguir.

=

&=

M

| Horizontal and Extension
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Para alinhar as tubagens, basta selecionar uma delas e no separador Modify | Pipes selecionar a
4+

*o . . . .
ferramenta Move * . Selecionar o ponto no meio da nova tubagem e em seguida o ponto do meio da
tubagem da sanita.

Endpoint

Deve-se entdo selecionar a conexdo e pressionar a tecla delete para a excluir.

Para unir as tubagens sera utilizada uma ferramenta muito Util para realizar estes processos no Revit, que
—

=
é a ferramenta ”1Trim/Extend to Corner. Esta ferramenta pode ser utilizada sempre que for preciso
conectar tubagens. Para isso, é preciso selecionar uma das tubagens e no separador Modify | Pipe,
selecionar a ferramenta Trim/Extend to Corner.

oo

£ O_" Zeah oa Ul
%3O T:TH H %
Modify
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Com a ferramenta selecionada, basta clicar nas duas tubagens e a conexdo serd adicionada
automaticamente.

Os demais equipamentos também serdo conectados de forma mais otimizada, como os lavatdrios. Este
tipo de lavatério tem por definicdo um didmetro de 25 mm para a ligacdo de agua fria. Deve-se realizar a
alteracdo desta medida, clicando sobre o elemento e na janela Properties clicar em Edit Type.
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M_Lavatory - Rectangular
560 mmx560 mm - Private

Plumbing Fixtures (1)

Constraints
Schedule Level
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+ | 08 Edit Type

-

M

Ground Floor

Elevation from Level

0.8650 m

Host

Linked Revit Model : Prgj...

Plumbing
Flow Pressure

155158000000 Pa

Mechanical
System Classification

Domestic Cold Water,Do...

System Type

Domestic Cold Water

System Name

Domestic Cold Water

System Abbreviation

Identity Data A
Image
Comments v
Properties help Apply

Serd aberta a janela Type Properties e deve-se alterar o parametro Cold Water Diameter para 15 mm.

Type Properties X
Family: M_Lavatory - Rectangular ~ Load...
Type: 560 mmx560 mm - Private E Duplicate...
Rename...

Type Parameters

Parameter Value ‘:‘ =
Constraints &
Default Elevation 0.8650 m
Materials and Finishes A
Sink Material <By Category=
Faucet Material <By Category>
Dimensions A
Sanitary Radius 16.0 mm
Sanitary Diameter 32.0 mm
Sink Width 03810 m
Sink Length 0.3050 m
Lavatory Length 0.5600 m
Lavatory Width 0.5600 m
Hot Water Radius 7.5 mm
Hot Water Diameter 15.0 mm
Cold Water Radius 7.5 mm
Cold Water Diameter 15.0 mm
Mechanical A

What do these properties do?

<< Preview Cancel Apply

Da mesma forma que foi feito com o bidé e a sanita, os dois lavatérios serdo conectados para otimizar a
tubagem. Entdo deverdo ser excluidas as conexdes dos lavatérios e em seguida criar novas conexdes com
a ferramenta “In” do equipamento.
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Com a utilizagdo das ferramentas mencionadas, conectar o chuveiro, banheira, lavatdrios, bidé e sanita
numa configuragdo semelhante as imagens a seguir.
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Recomenda-se fazer altera¢Ges semelhantes em outras regides do sistema, de modo que sejam criadas
melhores solugdes para que o mesmo fique melhor distribuido.

Para auxiliar no tracado dos ajustes do sistema, pode-se abrir as vistas dos algados (Elevations) pelo

Navegador de Projeto, e também criar vistas de cortes utilizando a ferramenta Sections @ na Barra de
Ferramentas de Acesso Rapido.

Uma das possiveis solugdes, pode assemelhar-se as imagens abaixo
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Com o sistema de distribuicdo de agua ja estruturado nos ambientes da moradia, deve-se tragar uma
ligacdo do sistema predial a rede publica. Neste projeto ndo esta representada a localiza¢cdo do ponto da
rede publica, portanto, sera feita uma aproximacao.

O ponto em que a tubagem de conexdo com a rede publica se ligard com o sistema, esta assinalado a
vermelho na imagem abaixo.
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Para iniciar o tracado do troco de conexao com a rede publica, deve-se abrir a vista “2 — Plumbing”,
correspondente ao Ground Floor.

No separador Systems, painel Plumbing & Piping, selecionar a ferramenta Pipe.

NEY=SEEY

Pipe Pipe Parallel ﬁ Plumbing Sprinkler
Placeholder Pipes '13:}, Fixture

Plumbing & Piping El

Na Barra de Opcdes, alterar o parametro Diameter para 40mm e Middle Elevation para -0,40m.

Modify | Place Pipe Diameter: | 40.0 mm w Middle Elevation: | -0.4000 m v

Na planta do piso, aproximar o cursor do rato da area circulada em vermelho na imagem anterior e tracar
um pequeno trecho de tubagem até aproximadamente metade da parede, conforme a imagem abaixo.
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Excluir a conexdo existente entre as duas tubagens, clicar na extremidade da tubagem na horizontal e
arrasta-la até o encontro com a nova tubagem de 40mm.

{I.ZULU m
_

Serd criada automaticamente uma conexdo entre as duas tubagens, ja com o redutor de diametro (de 40
mm para 15 mm) acoplado.
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Para conectar novamente a tubagem na direcdo vertical, clicar sobre a mesma e arrasta-la até encontrar-
se com a tubagem que estava conectada anteriormente.

As conex0des dessa area devem se assemelhar a imagem abaixo.

Deve-se agora arrastar a tubagem até o limite do terreno. Para isso, abrir a vista 3D e no cubo de
visualizagdo clicar em TOP, para visualizar o desenho de cima, tal como numa vista de planta. A diferenga
€ que na vista 3D é possivel visualizar os limites do terreno.

Com isso, clicar na extremidade da tubagem de 40mm e arrasta-la na diagonal até se encontrar com o
limite do terreno.
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Apds estender a tubagem, clicar sobre a mesma para seleciona-la. No separador Modify | Pipes, painel
Edit, selecionar a opgao Cap Open Ends, para fechar a extremidade ndo conectada desta tubagem, pois a
ligacdo com a rede publica é feita pela companhia de agua local.

:ﬁa
Cap
Open Ends

O aspeto deve ficar semelhante ao da imagem abaixo.
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Apés estruturar toda a rede, deve-se realizar algumas alteracdes nos didmetros e conexdes em alguns
trogos. Na imagem a seguir, estdo identificados os trogcos que requerem alteracdo de diametros. Os trogos
com verde, devem ser alterados para 40mm e os trogos de cor amarela para 25mm. Os restantes, devem
ser mantidos com diametro de 15 mm.
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A alteracdo é feita de forma muito simples, basta clicar sobre a tubagem que se pretende alterar e na
Barra de Opc¢des (Modify Pipe) no parametro Diameter selecionar o valor desejado (25mm ou 40mm).

E muito importante verificar se ao alterar o didmetro da tubagem, o didmetro da conex3o foi alterado
automaticamente. Caso ndo tenha alterado, deve-se clicar sobre a conexao e na Barra de Op¢des (Modify
Pipe Fittings) no parametro Diameter selecionar o valor desejado (25mm ou 40mm).

5.6.3 Anotagoes

Para inserir elementos de anotacdo, como por exemplo identificadores do diametro das tubagens, deve-
se aceder ao separador Annotate, painel Tag, e selecionar a ferramenta Tag by Category.

o
(@
Tag by

Category
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Com a ferramenta selecionada, aproximar o cursor do rato do elemento a ser identificado e o texto de
identificacdo aparecera, com o diametro correspondente ao elemento. Posicionar o texto conforme o
desejado e clicar sobre o elemento para inserir a identificacdo.

‘ |

15 mMmg

[Pipes: Pipe Types : PVC - DWV |

Neste caso, o texto ficou demasiado grande para a escala do desenho. Para alterar o tamanho do texto,
deve-se clicar duas vezes sobre o texto, e entdo sera aberto o separador Modify | Label. Clicar uma vez
sobre o texto “Size” para seleciona-lo.

Size

Com o texto selecionado, na janela Properties clicar em Edit Type.

Properties X
Label .
P
Pipe Tags (1) - | Edit Type
Graphics A oA
Sample Text Size..
Label | Edit..
Wrap between paramet....[]
Horizontal Align Center
Vertical Align Middle
Keep Readable [ ]
Visible [ ]
N W
Properties help Apply

Serd aberta a janela Type Properties, na qual deve-se editar o parametro Text Size para 0,8 mm.
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Type Properties X
Family: System Family: Label i Load...
Type: L = Duplicate...
Rename...

Type Parameters

Parameter ‘ Value ‘ :|
Graphics B
Color W Black
Line Weight 1
Background Opaque
Show Border O
Leader/Border Offset 2.0320 mm
Text A
Text Font Arial
Text Size mm
Tab Size 12.5000 mm
Bold O
Italic O
Underline O
Width Factor 1.000000

What do these properties do?

<< Preview Cancel Apply
Apés editar o tamanho do texto, no painel Family Editor, clicar no icone Load into Project.

Edit JLoad into Load into
Label § Project JProject and Close

Label Family Editor

Uma janela surgirad avisando que a Familia ja existe, clicar na opgao “Overwrite the existing version”.

Family Already Exists x
You are trying to load the family M_Pipe Size Tag, which
already exists in this project. What do you want to do?
—» Overwrite the existing version

—> Overwrite the existing version and its parameter
values

Cancelar

Click here to learn more

Agora o texto estd de um tamanho mais adequado, se for preciso, pode-se edita-lo novamente para
aumentar ou diminuir ainda mais o texto.
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.
Para arrastar o texto para junto a tubagem que o mesmo representa, deve-se clicar no icone *+ localizado

logo abaixo do texto, e arrasta-lo para o local desejado.

Realizar o mesmo procedimento para todas as tubagens, de modo que fique semelhante a imagem a

seguir.

15 mma

P 15 mme 15 mme
| L

Também pode-se utilizar a ferramenta Tag All, no separador Annotate.

[ @

Tag by | Tag
Category| All

Na janela Tag All Not Tagged, selecionar na coluna Category a opgao Pipe Tags.
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Tag All Not Tagged X

Select at least one Category and Tag or Symbaol Family to annotate
non-annotated objects:

(®) All objects in current view
Only selected objects in current view

|:| Include elements from linked files

Category Loaded Tags 2
[ [Mechanical Equipment Tags M_Mechanical Equipment Tag :
[ FNurse Call Device Tags M_Nurse Call Devices Tag
Pipe Tags M_Pipe Size Tag
[ ] Plumbing Fixture Tags M_Plumbing Fixture Tag : Boxe
[ fRoom Tags M_Room Tag : Room Tag
[ Security Device Tags M_Security Devices Tag
[ |Space Tags M_Space Tag : Space Tag
[ Sprinkler Tags M_Sprinklers Tag
[ Telephone Device Tags M_Telephone Device Tag
I =l Tance KA W2l Tam s 1P N
I:‘ Leader Leader Length: | 12.7 mm
Tag Orientation: | Horizontal e
oK Cancel Apply Help

Ao clicar em OK, sdo adicionadas as identificagdes em todas as tubagens existentes no projeto. Contudo,
muitos textos acabam por se sobrepor e é preciso realizar ajustes manuais de qualquer forma.

5.6.4 Criar tabelas

A criacdo de tabelas para o Revit MEP, é feita da mesma forma que para o Revit Architecture, o que muda
sdo as informacgbes exibidas em cada tipo de tabela. Para exemplificar, serd criada uma tabela na qual
consta informacg0es sobre as tubagens.
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Para iniciar a criacdo de uma tabela, no Navegador de Projeto, em Schedules, clicar com o botdo direito
do rato e a seguir selecionar a opgdo New Schedule/Quantities.

New Schedule/Quantities...

Properties help Mew Graphical Column Schedule...
MNew Material Takeoff...

New Sheet List...

Project Browser - MEP automatit

3D Views . New Note Block...
3D Plumbin New View List
- Elevations (Buil ew View List..
East - Plumi Browser Organization...
SNort: i E:u' Search...
outh - Plul Expand All
West - Plum

= Legends Collapse Selected

==} Schedules/Quantities (a Collapse All

Space Outdoor Air Schedule
Sheets (all)
2] Families
(=) [Qi] Groups
Detail
Model

A seguir na janela New Schedule, em Category, selecionar a op¢ao Pipes. Em Name, pode-se alterar o
nome da tabela, neste caso sera mantido “Pipe Schedule”.

New Schedule d
Category: Name:

MEP Fabrication Hange... ~ | Fipe Schedule
MEP Fabrication Pipew...

Maodel Groups (@ Schedule building components

Parts
Pipe Accessories (O Schedule keys

Pipe Fittings

Pipe Insulations

Pipe Placeholders

Phase:
Piping Systems

Plumbing Fixtures

Rooms

RVT Links hd

MNew Construction b

Na janela Schedule Properties, no separador Fields, selecionar os seguintes parametros para a tabela:
Connection Type, Diameter, Flow, Length, Material, System Name, Top Elevation e Velocity.
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Schedule Properties X

Fields Filter Sorting/Grouping Formatting Appearance

Select available fields from:

Fipes L

Available fields: Scheduled fields (in order):
~| & |Connection Type
Assembly Code Diameter
Assembly Description Flow

Assembly Name += Length

Bottom Elevation Material
Comments System Name
Cost Top Elevation
Count Velocity

Critical Path

Description

Family

Family and Type

Fixture Units &

Flow State |j

Friction

Friction Factor Jx

IfcGUID W

Image hd 5

i 7 -4

[Jinclude elements in links

Ao clicar em OK, a tabela sera criada com todas as informacgdes que foram selecionadas. Caso seja feita
alguma alteragdo no projeto, a tabela é atualizada automaticamente, e vice versa.
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<Pipe Schedule>
A B C D | E | F G H
Connection Type Diameter Flow Length Material System Name Top Elevation Velocity
Generic 15.0 mm 0.9LUs 038 m Palyvinyl Chloride - :Domestic Cold Water 10.22 m 4.8 mfs
Generic 15.0 mm 0.0L/s 3585 m Polyvinyl Chloride - ;Domestic Cold Water -0.19m 0.0 mis
Generic 15.0 mm 09LUs 0.03m Polyvinyl Chloride - :Domestic Cold Water 027 m 4.8 mfs
Generic 15.0 mm 0.9LUs 1.03m Palyvinyl Chloride - :Domestic Cold Water 0.87 m 4.8 mis
Generic 15.0 mm 09LUs 0.03m Palyvinyl Chloride - iDomestic Cold Water (0.93 m 4.8 mfs
Generic 15.0 mm 0.9LUs 1.03m Palyvinyl Chloride - :Domestic Cold Water 0.87 m 4.8 mis
Generic 15.0 mm 0.9LUs 0.03m Polyvinyl Chloride - :Domestic Cold Water :0.93 m 4.8 mis
Generic 15.0 mm 09LUs 0.04 m Polyvinyl Chloride - (Domestic Cold Water (048 m 4.8 mfs
Generic 15.0 mm 0.9LUs 0.04 m Palyvinyl Chloride - :Domestic Cold Water :0.93 m 4.8 mfs
Generic 16.0 mm 0.9L/s 1.03 m Palyvinyl Chloride - ;Domestic Cold Water (0.87 m 4.8 mis
Generic 15.0 mm 0.9LUs 0.03m Paolyvinyl Chloride - :Domestic Cold Water 0.93 m 4.8 mfs
Generic 15.0 mm 0.9LUs 150 m Polyvinyl Chloride - :Domestic Cold Water 2.36 m 4.8 mis
Generic 15.0 mm 09Us 053 m Palyvinyl Chloride - {Domestic Cold Water 1043 m 4.8 mfs
Generic 15.0 mm 0.9LUs 0.03m Palyvinyl Chloride - :Domestic Cold Water 0.48 m 4.8 mfs
Generic 15.0 mm 0.9L/s 1.03m Polyvinyl Chloride - ;Domestic Cold Water 0.87 m 4.8 mis
Generic 15.0 mm 09LUs 0.03m Polyvinyl Chloride - :Domestic Cold Water 1093 m 4.8 mfs
Generic 40.0 mm 19Us 14.02m Palyvinyl Chloride - :Domestic Cold Water  -0.18 m 1.5 mis
Generic 15.0 mm 09LUs 0.06 m Paolyvinyl Chloride - iDomestic Cold Water (048 m 4.8 mfs
Generic 15.0 mm 0.9LUs 0.07 m Palyvinyl Chloride - :Domestic Cold Water 10.27 m 4.8 mis
Generic 15.0 mm 0.9LUs 0.04 m Polyvinyl Chloride - :Domestic Cold Water 0.52 m 4.8 mis
Generic 15.0 mm 09LUs 0.04 m Polyvinyl Chloride - (Domestic Cold Water (0.82 m 4.8 mfs
Generic 15.0 mm 0.9LUs 1.76 m Palyvinyl Chloride - :Domestic Cold Water 10.52 m 4.8 mfs
Generic 16.0 mm 0.9L/s 0.93m Palyvinyl Chloride - ;Domestic Cold Water (0.77 m 4.8 mis
Generic 15.0 mm 0.0LUs 0.37Tm Palyvinyl Chloride - :Domestic Cold Water  -0.19m 0.0 m's
Generic 15.0 mm 0.0LUs 038 m Polyvinyl Chloride - :Domestic Cold Water :0.22 m 0.0 m/s
Generic 15.0 mm 09Us 015 m Palyvinyl Chloride - {Domestic Cold Water 1043 m 4.8 mfs
Generic 15.0 mm 0.0Lls 3.04 m Palyvinyl Chloride - :Domestic Cold Water 10.27 m 0.0 m/s
Generic 15.0 mm 0.0L/s 049 m Polyvinyl Chloride - ;Domestic Cold Water :0.27 m 0.0 mis
Generic 15.0 mm 09LUs 057 m Polyvinyl Chloride - :Domestic Cold Water 0.87 m 4.8 mfs
Generic 15.0 mm 0.0Lls 038 m Palyvinyl Chloride - :Domestic Cold Water 0.22 m 0.0 mis
Generic 15.0 mm 09LUs 0.84 m Paolyvinyl Chloride - iDomestic Cold Water (0.27 m 4.8 mfs
Generic 40.0 mm 0.0LUs 6.77T m Palyvinyl Chloride - iDomestic Cold Water -0.38 m 0.0 m/s

5.6.5 Criar vistas isomeétricas

Para uma melhor representacdo do projeto, pode-se criar vistas isométricas da rede. Para posicionar o
desenho em uma vista isométrica, basta abrir a vista 3D e clicar em um dos cantos do cubo, conforme a
area em azul na imagem abaixo.

Para criar uma vista isométrica geral da rede, primeiro deve-se duplicar a vista 3D. Para isso, no Navegador
de Projeto, clicar com o botdo direito do rato sobre a vista 3D Plumbing, depois em Duplicate View e entao
em Duplicate. Renomear a vista para “Isometric Plumbing”.

45



Co-funded by the
V E T 3 Revit MEP Erasmus+ Programme
! of the European Union

w 3D View T

Open Sheet
3D View: 3D Plumbing Close
Graphics Show Camera
View Scale 1:10 Apply Template Properties...
\ .
scale Value 1: 100 Create View Template From View...
Detail Level Medit . . :
Parts Visibility Shov | IRl o T -
Visibility/Graphics Overr... Convert to independent view Duplicate with Detailing
Annl r \ m v ¥
Graphic Display Options Apply Dependent Views... Duplicate as a Dependent
e Save to Project as Image...
Discipline Plumk N -
Show Hidden Lines  ByDie ~ Delete T
Properties help Engy g vea -
Rename... e ™ B
Project Browser - MEP automatici Select All Instances > 0( 7 -
- HVAC . L P
H v - - <
= Plumbing Al EdEs 0{‘:, ~
E| Floor Plans Save to New File... 95‘/
! ; ) E:Umzing Search...
o2 umbing Expand Al
[=]- 3D Views

(- Collapse All
B Elevations (Building Elevation)

- East - Plumbing

MNorth - Plumbing

South - Plumbing

West - Plumbing

Os niveis ndo serdo necessarios nesta vista, portanto é possivel oculta-los. Para isso, para clicar sobre um
dos niveis com o botdo direito do rato, clicar em Hide in View e selecionar a opgao Category.

Cancel

P

4

Repeat [Select links]

Recent Commands >
Drag End

Go to Floor Plan

Maximize 3D Extents

Hide in View > Elements
Override Graphics in View > Category

Create Similar By Filter...

Edit Family

Select Previous

Select All Instances >
Delete

Com a isometria posicionada de acordo com a imagem abaixo, a posi¢do sera fixada.
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Para fixar a posicao, na barra de visualizagdo, basta clicar no icone f‘% Locked 3D View, e selecionar a
opcao Save Orientation and Lock View. A vista entdo nao poderd ser rotacionada.

ﬁ Save Orientation and Lock View

Restore Orientation and Lock View
Unlock View

F Sk & GBS ¢ tam @l a <

E importante definir a regido de recorte da vista, para quando a mesma for inserida numa folha para

=y . e
impressdo ja esteja ajustada. Para isso, clicar em =3 Show Crop Region, na barra de visualizagao.

Fox xGRER e ¢ adaE <

Serd exibido o retangulo com a regido de recorte. Clicar sobre o retangulo e ajusta-lo para que fique bem
proximo dos limites do desenho, conforme a imagem abaixo.
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o

Depois de ajustar a regido de recorte, na Barra de visualizagdo, selecionar a opgao Ay Hide Crop Region,
para ocultar a regido de recorte.

Mk & GRER > ¢ i &2 <

A vista isométrica geral esta criada. Agora sera criada uma vista isométrica de uma casa de banho. Para
isso, duplicar a vista “Isometric Plumbing” e renomear para “Isometric Plumbing Bathroom”.

Com a vista “Isometric Plumbing Bathroom” aberta, clicar no icone @
op¢do Unlock View, para voltar a permitir a movimentagao da vista 3D.

Unlock 3D View, e selecionar a

Save Orientation and Lock View

Restore Orientation and Lock View

r% Unlock View
F & &GO EeEBlish> ¢ GGl e <

Rotacionar a vista 3D através dos cantos do cubo de visualizacdo, até chegar na vista conforme a imagem

€3

a seguir. Depois de posicionada, voltar a clicar no icone 2 ocked 3D View. O circulo vermelho representa

o0 ambiente para o qual sera criada a vista isométrica.
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Para recortar a vista isométrica somente do ambiente desejado, pode-se utilizar a ferramenta Section Box.
Para habilita-la, basta marcar a opgdo Section Box na janela Properties da vista.
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Surgird entdo uma Caixa de selecdo, a qual é possivel ajustar para recortar somente o ambiente desejado.

Revit MEP

Properties

fta 3D View
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“ Edit Type

3D View: Isometric Plumbing
Scale Value 1: 100 ~
Detail Level Medium
Parts Visibility Show Qriginal
Visibility/Graphics Overr... Edit...
Graphic Display Options Edit...
Discipline Plumbing
Show Hidden Lines By Discipline
Default Analysis Display...None
Sub-Discipline Plumbing
Sun Path ]
Extents A
Crop View ]
Crop Region Visible ]
Annotation Crop ]
Far Clip Active ]
Far Clip Offset 304.8000 m
Scope Box Maone
Section Box
Camera 8
Rendering Settings Edit... o

Properties help

Apply
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i
Nota: Caso a Caixa de Selecdo n3o esteja visivel, deve-se clicar em * Reveal Hidden Elements, na barra
de visualizacdo e entdo a mesma ird aparecer.

Utilizando as setas da Caixa de Selecdo, deve-se arrasta-las ou clicar na direcdo em que pretende-se mover
o limite de Caixa, até chegar num resultado semelhante ao da imagem abaixo.

<

A

Para ocultar a Caixa de Selecdo, deve-se clicar com o botdo direito do rato sobre a mesma, clicar em Hide
in View e selecionar a opgao Elements.
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Cancel

Repeat [Hide Elements]

Recent Commands >

Hide in View > Elements
Override Graphics in View > Category
Create Similar Hy i
Edit Family

Select Previous

Select All Instances > B

Delete

Reset Crop Boundary to Model
Reset Crop Boundary to Screen
Find Referring Views

Zoom In Region

Zoom Out (2x)
Zoom To Fit

Previous Pan/Zoom
Next Pan/Zoom

h'4

Browsers >

~  Properties
O mesmo podera ser feito para os equipamentos sanitarios (pia, sanita, duche) caso desejar que so6 as
tubagens e conexdes aparecam na vista isométrica, como na imagem abaixo.

5.6.6. Criar Folhas

A criagdo de folhas para impressao, é feita exatamente através do mesmo procedimento descrito no
tutorial do modelo de arquitetura (ver item 5.11 do tutorial Revit Architecture). Neste caso, seguindo as
mesmas instrucdes, deve-se criar uma ou mais folhas que contenham as duas vistas de plantas e as duas
vistas isométricas que foram criadas neste tutorial.
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